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This section will show how to use the new project wizard and to import existing files 

8

into the project. 



In order to use the New Project Wizard, you can only get to it from File->New-

>Kinetis Design Studio. If you use the “add” icon, the New Project Wizard is not a 

selection.
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The filter is a quick way to find the part you are looking for.

In the New Project Wizard, you select the base part. You will need to specify the 

specific part, including package & pins, you are using. This is done in the Properties

tab of the Processor Component.
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Select Kinetis SDK (this will be selectable for processors that are supported by the 

SDK). Start with Perspective: Lets set this to the non-processor expert hardware 

configuration perspective and select Linked project mode. The Standalone project 
mode is not functional in the this Beta release. If you use “Linked” mode, and you 

modify the contents of the code, then you are modifying the reference code. 

If you plan on archiving the project or sharing the project, this assures the entire 
project is included, all the source files, etc.
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Processor Expert is working…
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After the New Project Wizard, you end up in the standard C/C++ perspective with 

the Processor Expert view also turned on. So, you see the Component Inspector 

and the Component View as defaults.

There may be errors in the “problems view”. These will be removed as we configure 
the part.
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Select the CPU and Open up the window a bit for better visibility.
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Here in the component library, we select the components needed for our project.
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We are pulling in the components here. One for the switches and LED’s, one for the 

interrupt timer, and one for the serial port.

An alternative to “double click” on the component, one could right click and select 

“add to project”..

19



Scroll down and select the fsl_uart.
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With all our components added to the project, we will move on to configuring the 

components. Starting with the CPU. Notice there are errors in the components. This 

is normal behavior, since the components have not been configured just yet.

21



These are the settings we will use for the next set of slides. This is the hardware 
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spec that we will be setting the chip up for.



When looking at this perspective, notice the error messages in the “Problems” view. 

These problems will be rectified as we configure the different components. 
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Selecting the “package” of the chip. Remember that each chip has several 

packages, selecting the proper package here is vitally important to have the proper 

pin muxing.
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Based on the hardware design, the system has a 50MHz clock source, not a crystal. 
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The input clock is set for 50MHz and now we will setup the clock configurations 

MCG
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Here we are setting up the MCG. The board has an external 50MHz signal, and so 

to operate at maximum speed of the chip, the us of the PLL clock is required. So, 

select PEE, and set the PLL output to 120MHz.

Scroll down and select “Clock configurations” tab
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With the PLL set to 120, the system clocks need to be addressed. 

Core Clock = 120MHz

Bus Clock   = 60MHz

External bus Clock = 60MHz

Flash Clock = 24MHz

This completes the clocking configuration. Next we move onto other CPU settings.
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Since our project does not require an nmi interrupt routine, we will uncheck this box. 

Also, if you are using the nmi pin as a signal pin, like the FRDM board.

This completes the configuration of the cpu. Now its time to move onto the 

component configurations.
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Now select the “pin_mux:PinSettings” from the component view
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Since the package has changed from the default, the system lets you know the 

configuration will change.
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Now we move into the pin settings. And our io’s will be:

LED’s are on ports PTB-21, PTB-22, and PTE-26

SWitches are on ports PTA-4, and PTC-6

UART is on PTB-16, and PTB-17
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This is a summary list of the pins we are going to use for this project. 
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Now select the GPIO tab.
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Summary of pins

Port Number Function Name DirectionPort Number Function Name Direction

PTA4 SW3 Input

PTB21 LED_BLUE Output

PTB22 LED_RED Output

PTC6 SW2 Input

PTE26 LED_GREEN Output
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Now we will configure the pin properties.

36



For the switch inputs, the switches require the use of the internal pull-up since there 

is no external pull-up on the schematic.
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In the User/Pin Signal Name column, you can enter names here that will be easier 

to remember or the same labels that are on your schematic.
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Setting the pin mux for LED_RED

Summary of pins

Port Number Function Name Direction

PTA4 SW3 Input

PTB21 LED_BLUE Output

PTB22 LED_RED Output

PTC6 SW2 Input

PTE26 LED_GREEN Output
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Summary of pins

Port Number Function Name Direction

PTA4 SW3 Input

PTB21 LED_BLUE Output

PTB22 LED_RED Output

PTC6 SW2 Input

PTE26 LED_GREEN Output
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Setting the Pin Mux for LED_BLUE

Summary of pins

Port Number Function Name Direction

PTA4 SW3 Input

PTB21 LED_BLUE Output

PTB22 LED_RED Output

PTC6 SW2 Input

PTE26 LED_GREEN Output
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Scroll down to PTC (Port C) and select the GPIO pin 6, this is for the SW2 settings.

Summary of pins

Port Number Function Name Direction

PTA4 SW3 Input

PTB21 LED_BLUE Output

PTB22 LED_RED Output

PTC6 SW2 Input

PTE26 LED_GREEN Output
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Again, for the inputs, we need to select the pin functional properties
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For the switch inputs, the switches require the use of the internal pull-up since there 

is no external pull-up on the schematic.
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One more setting for GPIO, that would be LED Green PTE26 Output
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Scroll down to PTE (Port E) and LED Green PTE26 Output

Notice that when you change the name of the User Pin/Signal Name, the 

“Pin/Signal Selection” also changes name. We will use these user names when we 

set up the drivers. 

Now we move onto the UART pin muxing
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Here are the pins we need to deal with for the UART. This uart is connected to the 

debug interface chip on this board, and it allows for the uart to print on the PC 

terminal window.
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There is no real need to give this pin a user name, since we will use the uart as a 

module. we can and will leave this at the default name. For your own design, you 

may want to rename this to match your schematic.

Notice there are errors showing up. 
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The error message indicates a conflict with “uartCom1”, which we have not 

configured yet. These errors will be corrected when the uart component is 

configured.
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At this point we can now configure the drivers. The first on our list is the 

gpio1:fsl_gpio. There are 2 inputs that are needed for our project, click the ‘+’ twice. 

There may already be gpio pins set. If this is the case, we can delete them since our 
project does not need them. If you were adding gpio’s to an existing project, then 

you would expect the pins to be listed.
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By selecting the row, which in this case is pin #1, select the details for this pin we 

added. Since we assigned “SW2” as an input with pull ups enabled, that selection 

carries over to this panel. Now do this again for pin #3, and call I “SW3”. The 
selection that shows row 0 as an input pin is not being used by this project. This can 

be removed. This is an errata.
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By selecting the row, which in this case is pin #1, select the details for this pin. 

Since we assigned “SW3” as an input with pull ups enabled, that selection carries 

over to this panel.
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Its time to move to the output pins. Add 3 output pins, one each for RED, GREEN, 

BLUE.
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Scroll down to see the pin settings properties. Click or select row 1, which is the first 

of the rows (pins) that we added. 
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At this point, the pin will be assigned based on the pin_mux names that was used in 

the pin_mux settings section. As you enter the pin name, the dropdown list will filter 

as you enter the name. So, after entering “LED” the three LED_ names pop up. You 
can either keep typing the name or select the name from the list.
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Set the output logic to 1. So the default state of the LED is OFF.

And it looks like this…
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Scroll down to see the pin settings properties. Click or select row 2 and enter 

LED_GREEN, and set output logic to 1
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Scroll down to see the pin settings properties. Click or select row 3 and enter 

LED_RED.

60



Now we move to the interrupt timer (PIT) and set it to 1000mS.
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Here the pins are selected and the baud rate is selected.
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To generate Processor Expert Code, press on this icon. Also, if you hover over the 

icon, it gives you an indication of what it does.

As with most programs, there are always more than one way to do something, and 

this is no exception. To generate Processor Expert code, you can also click on 

Project -> Generate Processor Expert Code.
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A quick check of some of the generated code. When you expand the generated 

code section in the Project, you will see listings of header and c files. 
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A quick check of some of the generated code. The “Sources” folder includes other 

source files, including main.c and events.c.

Events.c is where the interrupt callback routines are placed. The project has the 

GREEN_LED blinking based on the interrupt timer, this is where the code is placed 

to blink the LED.
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In “events.c” the interrupt callback is installed. Here is where we will put the blink 

the led code. Please note the “/* Write your code here … */”
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Simply “drag & drop” gpio_toggle_pin_output”  to the Events.c file. Make sure this is 

between the {}.

This sets up the call back routine to turn the LED on/off.
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For the gpio_toggle_..., a parameter needs to be passed. Since we want the 

GREEN led to blink at the timer.”LED_GREEN” was defined when we set the pin 

name.
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Looking at KDS Help, there are three ways to import files. We will demonstrate the 

“drag and drop” method in this exercise. Remember, in our OS’s, there are always 

more than one way to do any particular task.
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Find the file you want to use…
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And Drag & Drop into the “Sources” folder. Or copy/paste it into the “Sources” folder
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Select the appropriate import. We will use “Copy files”. This allows for the user to 

modify the sources without effecting the original sources. 
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Now the file is included in the “Sources” folder.
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Around line 40 to add the declaration of “my_main” and the call around line 51.

Be sure the call is included after the line “/* Write your code here */
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Right now we will clean the project. I make it a habit to clean a project especially 

when there are files imported or if the entire project is imported. This ensures that 

there are no artifacts carried over from the import.
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The project is cleaned and ready to build…
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Right click on the project you wish to build. Then select build. One could also select 

the project then using the menus “Project -> Build”.
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Build Progress – Just like most Eclipse based tools.
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These includes are what is generated and needed by Processor Expert.

This is an auto generated file. All we need to add is our declarations and a call to 

our code. 
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This set of code is your events handler. Every where you included an interrupt for 

the peripheral module, PEx generates a routine in this file.
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The first thing that you need to do before debugging, is to setup the debug 

configuration. To get to the debug configuration for your project, highlight the project 

(by selecting it) and then click on the “▼”, and select “Debug Configurations…”
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KDS is based on stock eclipse with our Processor Expert Plug-ins and base debug 

configurations. The base debug configurations are GDB. With this version the GDB 

includes OpenOCD, P&E Micro and Segger J-Link. 
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KDS is based on stock eclipse with our Processor Expert Plug-ins and base debug 

configurations. The base debug configurations are GDB. With this version the GDB 

includes OpenOCD, P&E Micro and Segger J-Link. 
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The “Start OpenOCD locally” option allows for the OpenOCD executable to be 

started by the tools. The other option is to start the OpenOCD manually and then 

KDS will find it via the GDB port.

The “Allocate console…” selection MUST be selected in order to start the debug 

session. 

With GDB as the debugger engine, this will allow for remote debugging. The tools 

on one machine, and the UUT and GDB server on another machine. To set that up, 

use the GDB Hardware Debugging and setup the server IP address, connection 
(JTAG Device), and port number of the remote machine.
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In Other options, you must enter the type of interface and the target configuration 

-c “interface cmsis-dap” –f target\k64.cfg file location. Be sure to enter -c “interface cmsis-dap” –f target\k64.cfg into the 

“Other options:” box. This can be on a single line or separate lines. I chose separate 
lines for readability.
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Defaults for the “Startup” tab, and recommend to check the “Shared file” for the 

debug configuration. This will bundle the configuration file with the project when 

exported.

The Startup panel is where you would set the initial breakpoint for the debugger. By 

default, it stops at main.

The Common tab has the “Shared file” selection. Check this if you want the debug 

configuration to be included in the project when you export the project.
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All Defaults

The Startup panel is where you would set the initial breakpoint for the debugger. By 

default, it stops at main. If you want to stop at a particular place, you can enter an 

address, or function name.
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Click “Apply” then click “Debug” this will launch the debugger.
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Click checkbox, so you do not get this again. What is happening here, is that 

Eclipse wants to change to the Debug perspective, If you do not want to see this 

dialog again, just check this box, and never to see this again.
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Immediately after the Download task is completed, the perspective automatically 

changes into the Debug Perspective. This perspective has a variety of windowing 

possibilities, by default this perspective gives you 5 major windows. The Debug 
window, the inspection window, source code window, and the console window. 

Within the Inspection and Console window space, there are other choices of things 

to view.

Another item, which is set by default, the code automatically breakpoints after main. 

This choice can be changed in the Debug Configuration
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Since the Step “into” was selected on the base line of PE_low_level_init(); the editor 

moves to the first line of the call. Now we will do a single step, which will take us to 

the next function call of this routine.
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This will stop over the “PE_low_level_init and stop at my_main
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Notice the sendstring printed on the terminal and the green LED should be blinking.
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With the program running, now click the “Suspend Icon”
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Expand the Registers View and expand the User/System Mode Registers 
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With the register window open, single step over, multiple times and see the register 

value change as the code steps through the delay function.

Now  click the suspend button. 
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Set breakpoints by double clicking in the margin next to the line you wish to break 

point. In this case we want to break point at line 36.
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Lets turn off a breakpoint at “my_main” and continue to run the program. Press the 

buttons and see the pretty lights go on an off. 

Did we meet our design goals?
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Start with Perspective: Lets set this to the non-processor expert hardware 

configuration perspective. Select Kinetis SDK (this will be selectable for processors 

that are supported by the SDK), and select Standalone project mode. This allows 
for you to modify the files and settings to suite your needs without effecting the files 

stored on disk. If you use “Linked” mode, and you modify the contents of the code, 

then you are modifying the reference code. 

If you plan on archiving the project or sharing the project, this assures the entire 

project is included, all the source files, etc.
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